
An Overview of
Access

P A R T I

L E A R N  T O :

• Get around in Access

• Use Access in one short

evening

• Open databases and 

projects

• Make the most of Access,

Office, and Windows

together

2326ch01.qxd  5/19/99 6:41 AM  Page 1

CO
PYRIG

HTED
 M

ATERIA
L



2326ch01.qxd  5/19/99 6:41 AM  Page 2



CHAPTER 1
Getting Started
and Getting
Around

F E AT U R I N G :

Starting Access 5

Opening and closing a database 9

Working in the database window 16

Getting help when you need it 27

2326ch01.qxd  5/19/99 6:41 AM  Page 3



M icrosoft Access is a database management system, or DBMS. As the
name implies, a DBMS helps you to manage data that’s stored in a
computer database. The data you manage can be virtually anything,
including:

• Names and addresses

• Business contacts, customers, and sales prospects

• Employee and personnel information

• Inventory

• Invoices, payments, and bookkeeping

• Libraries and collections

• Schedules, reservations, and projects

You may already know what kinds of data you plan to manage with Access, and
you may already be familiar with other database programs and the basic concepts of
database management. If not, you’ll learn more about databases in the next chapter.
But whether you’re a seasoned veteran eager to start working in Access or a database
newcomer wondering where to begin, the first step is to learn how to start Access and
use its extensive Help system to coach you along as you work.

Access Isn’t Just for Techies!
Don’t worry if you know nothing about databases and don’t want to become an expert
on the topic. Access wizards can guide you through almost any step, and they can cre-
ate databases for you automatically. So even if you need to set up something as com-
plex as a system for managing orders, inventory, or assets—or something as simple as
a list of contacts and birthdays—Access wizards can take care of the grunt work while
you focus on getting useful information from your computer. You’ll have a chance to try
wizards during the hands-on tour in Chapter 3 and in many other chapters of 
this book.

If you’re a technical type, never fear! Access has more than enough to make you happy.
It’s a full-featured application development system that includes the Visual Basic pro-
gramming language and other tools for setting up sophisticated applications for your-
self and your customers. You’ll learn more about these features in Parts Four and Five.
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5

Starting Access
To start Microsoft Access:

1. Start Windows in the usual manner.

TIP If you’re using Microsoft Office and have added Access to the Microsoft Office
Shortcut Bar, you can start Access by clicking the appropriate button on the Office Shortcut
Bar (see Chapter 4). Or if you’ve set up a shortcut icon for Access on the Windows Desk-
top, you can double-click that icon to start Access. Then skip to step 3 below.

2. Click the Start button on the Windows Taskbar and then choose Programs ➣
Microsoft Access.

After a short delay, you’ll see the Microsoft Access startup dialog box shown in
Figure 1.1. (If you’ve just installed Access, the list box below the Open an Exist-
ing File option is empty.)

FIGURE 1.1
The Microsoft Access

startup dialog box.
From here you can
create a new data-

base, a data access
page, or a project. You
can also open an exist-
ing file, or click Cancel

to go to the main
Access window.

3. Do any of the following:

• To create a new blank database, choose Blank Access Database and
then click OK.

• To use the Database Wizard to create a new database, choose
Access Database Wizards, Pages, and Projects. Then click OK to open the
New dialog box. (There’s more about creating new databases in Chapter 5.)
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND6

• To create a data access page or a project, follow the preceding instruc-
tions for creating a new database. Then refer to Chapter 14 for details on
working with data access pages, or Chapter 30 for projects. (You’ll learn
more about the difference between databases and projects later in this chapter.)

• To open an existing database or project, choose Open an Existing
File. If a list of database names appears, choose a recently used database
name in the list or click More Files so you can look for the database you
want to use. Click OK. See “Opening an Existing Database or Project” later
in this chapter for more details.

• To go to the main Microsoft Access window (shown in Figure 1.2)
without creating or opening a database, click the Cancel button or press Esc.

FIGURE 1.2
The main Microsoft
Access window that
appears when you
click Cancel in the

startup dialog box and
anytime you close an

Access database. You’ll
also see this window if

Access is set up to
bypass the startup 

dialog box.

NOTE If Access is customized to bypass the startup dialog box, you’ll be taken to the
main Access window as soon as you finish step 2, above. We explain how to bypass the
startup dialog box later in this chapter.
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7

Advanced users can learn about optional command-line startup switches for Access
in Chapter 16 and by searching the Access Help index for Startup Options, Command-
Line Options. We’ll explain how to use Access Help in the “Getting Help” section, later
in this chapter.

Organizing the Start ➣ Programs Menu Items
If your Start ➣ Programs menu has too many entries or isn’t organized the way you like,
you can rearrange it easily. Suppose you want to move Microsoft Access and other
Microsoft Office programs from the main Start ➣ Programs menu into a Microsoft Office
submenu that looks something like the image below.

All it takes is a little knowledge of Windows Explorer and these basic steps:

1. Right-click the Start button on the Taskbar and choose Explore.

2. Click the Programs folder in the left pane of the Exploring window. (It’s below the
Start Menu folder.) The right pane will show the contents of the Programs folder.

3. Right-click your mouse on an empty part of the right pane of the Exploring window
and choose New ➣ Folder from the shortcut menu.

4. Type a new folder name, such as Microsoft Office, and press Enter.

STARTING ACCESS
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND8

5. Click the + sign next to the Programs folder in the left pane; then use the vertical
scroll bar to scroll the left pane until you can see the new folder you created and
named in steps 3 and 4.

6. Drag the program (or folder) you want to move from the right pane to your new
folder in the left pane.

7. Repeat step 6 as needed and then click the Close button in the Exploring window.

For more details on customizing the Start menu, choose Start ➣ Help and click the
Index tab. Then type Start Menu, Reorganizing and press Enter. To learn more about
Windows Explorer, look up topics below Windows Explorer on the Index tab in Help.

Creating a Desktop Shortcut
You can double-click a shortcut icon on the Windows Desktop to launch a program or
open a file. To quickly add an icon that will launch the Access program from the
Desktop, minimize or close any open windows and then follow these steps:

1. Use Windows Explorer to open the folder that contains Microsoft Access. For exam-
ple, right-click the Start button on the Windows Taskbar, choose Explore, and navi-
gate to the Program Files\Microsoft Office\Office folder. (It’s usually on
drive C.)

2. On the right side of the Explorer window, locate the Msaccess program icon. It will
appear as a key next to the program name, msaccess.exe.

3. Hold down the right mouse button while you drag the icon to the Windows Desk-
top. Release the mouse button.

4. Choose Create Shortcut(s) Here from the shortcut menu.

In the future, you can start Access by double-clicking the Shortcut to Msaccess.exe icon
on your Desktop. To discover other ways to create shortcuts for Access, look up the
Shortcuts topics in the Access Help index or the Windows Help index. (To get Windows
Help, click the Start button on the Taskbar and choose Help.)
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Opening an Existing Database or Project
In word processing programs, you work with documents. In spreadsheet programs,
you work with worksheets. In database management systems, such as Access, you
work with databases. Chances are you’ll want to create your own database. But you can
get some practice now by exploring one of the sample databases that comes with Access.

NOTE In Access, you can also work with projects stored in .adp files. A project holds
tools like forms and reports for working with SQL Server data. See “And What About Pro-
jects?” later in this chapter for more information on Access projects and how they are dif-
ferent from Access databases.

To open a database or a project:

1. Do one of the following, depending on whether you’re starting from the startup
dialog box, from the main Microsoft Access window, or from the Windows
Desktop:

• From the startup dialog box (refer to Figure 1.1), choose Open an Exist-
ing File. (This is the default choice.) Then if the name of the database or
project you want to open is shown on the list, double-click that name and
you’re done. If the name isn’t on the list, double-click More Files and con-
tinue with step 2. (If no list appears, click OK and continue with step 2.)

TIP As usual in Windows, you can choose an option from a list by clicking it and then
clicking OK (or whatever button carries out the default command), or by clicking the
option and pressing Enter. Or for quicker selection, try double-clicking the option you want.

• From the main Microsoft Access window (refer to Figure 1.2), choose
File ➣ Open,  click the Open toolbar button (shown at left), or press Ctrl+O.
You’ll see an Open dialog box, similar to the example shown in Figure 1.3.

TIP If you recently used the file you want to work with, try this tip to open it quickly:
Choose File from the menu bar, and look for the file name near the bottom of the File
menu (just above the Exit option). Then click its name or type the number shown next to
the name.

OPENING AN EXISTING DATABASE OR PROJECT
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND10

FIGURE 1.3
The Open dialog box.

• From the Windows Desktop, locate the desired database or project
using standard techniques in Windows Explorer, My Computer, or Net-
work Neighborhood. When you find the file you want to use, double-click
its name or icon (see the sample icon, shown at left). Or if you’ve used the
file recently, click the Start button on the Windows Taskbar, choose Docu-
ments, and then click the name of your database in the list that appears.
Access will start, and the database or project will open. You’re done, so you
can skip steps 2 through 4.

2. Use any of these methods to find the database or project you want to open:

• To see the files you opened most recently, click the button for History
on the left side of the Open window.

• To show the files in My Documents or on the Desktop without hav-
ing to navigate using the Look In drop-down list, click the My Documents
or Desktop button.
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11

• To open an object shown in the list below Look In, double-click the
appropriate object icon or name.

• To choose the computer, drive, or folder where the database is
stored, click the Look In drop-down list button and then click the appro-
priate item.

• To open the folder that’s just above the currently selected folder,
click the Up One Level button in the Open dialog box, or click anywhere in
the list below Look In and then press Backspace.

TIP To learn the purpose of any toolbar button in a window or dialog box, move your
mouse pointer to that button and look for the ScreenTip near the mouse pointer. See
“Using the Toolbars and Menu Bar” later in this chapter for more information.

• To display a list of your favorite databases and folders, click the
Favorites toolbar button. The list below Look In will then show your
favorite folders and databases only.

• To add an item to your Favorites list, make sure the appropriate item
appears in the Look In text box or click an item name in the list below Look
In. Then choose Add to Favorites from the Tools drop-down list.

• To manually enter a drive, directory, and/or file name, type the
appropriate information into the File Name text box in the lower part of 
the Open dialog box or choose an item from the File Name drop-down list.

• To change the appearance of the list below Look In, click the Views
button and select List, Details, Properties, or Preview.

• To search for a database or project, click the Tools drop-down list and
select Find to open a dialog box you can use for searching.

TIP You can delete, rename, and do other handy operations on items from the Open
dialog box. To begin, right-click an item in the list below Look In. Then choose an option
from the shortcut menu.

3. If you’re choosing the database or project from the list below Look In, make sure
its name is highlighted on the list. (Click the name if necessary.)

4. Click the Open button. (As a shortcut for steps 3 and 4, you can double-click a
filename in the list below Look In.)

OPENING AN EXISTING DATABASE OR PROJECT
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND12

The database or project will open, and you’ll see the database window or a form
that either describes the database or lets you work with it.

TIP If the database or project you’re planning to open usually displays a form, but you’d
prefer to bypass that form and go directly to the database window, hold down the Shift
key while you open the file. This action bypasses the form and any options that are set in
the Startup dialog box (Tools ➣ Startup).

As Figure 1.3 shows, the Open dialog box contains many buttons and special fea-
tures that we haven’t mentioned here. If you’ve played with other Open dialog boxes
in Microsoft Office or you’ve spent some time with Windows Explorer, you’ll learn
the fine points quickly. For more guidance, click the ? button in the upper-right cor-
ner of the Open dialog box and then click the part of the dialog box you’re curious
about. Feel free to experiment!

Opening the Sample Northwind Database
To use the Northwind database that comes with Access, you have to make sure it gets
installed. By default, it gets installed on first use, which means the first time you try
to use it, it will be copied from your Office CD to your computer. For this to work,
you have to select Northwind.mdb from the File menu before it gets overwritten by
other databases you open after you first install Access.

If you don’t find Northwind.mdb on the bottom of your File menu, run Setup for
Office again, and click Add or Remove Programs. In the window that lets you select
the programs to install, click the Expand button for Microsoft Access for Windows.
Then expand Sample Databases and change the setting for Northwind Database from
Installed on First Use to Run from My Computer. Then click Update Now. Once the
Northwind database is installed, you can open it this way:

1. Choose Open an Existing File from the Microsoft Access startup dialog box.
Then highlight More Files (if it’s available) and click OK.

Or

Choose File ➣ Open from the main Microsoft Access window.

2. Using the Look In drop-down list, navigate to the folder C:\Program
Files\Microsoft Office\Office\Samples.

3. Double-click Northwind.mdb in the list below Look In.

4. Click OK to go to the database window if the Welcome form appears.

2326ch01.qxd  5/19/99 6:41 AM  Page 12



13

Maximizing Your On-Screen Real Estate
The Windows Taskbar can take up valuable on-screen real estate that you might prefer
to make available to your database objects. Fortunately, hiding the Taskbar temporarily
and bringing it into view only when you need to is easy. (Most screen shots in this book
were taken with the Taskbar hidden.)

To hide the Taskbar temporarily, right-click any empty spot on the Taskbar, choose
Properties, make sure the Always On Top and Auto Hide options in the Taskbar
Properties dialog box are checked, and then click OK. In the future, the Taskbar will
remain hidden until you move your mouse pointer to the edge of the screen where the
Taskbar was lurking the last time you used it. (If you don’t remember where the Taskbar
was, move the mouse pointer to the bottom, top, left, and right edges of the screen
until it pops into view.)

To display the Taskbar permanently again, return to the Taskbar Properties dialog box
and deselect (clear) the Auto Hide option. (It’s usually best to leave Always On Top
checked.) Then click OK.

The objects (a term for database components, such as tables and forms) that are part
of the Northwind database will appear in the database window (see Figure 1.4). You
can move, size, maximize, minimize, and restore the database window using all the
standard Windows techniques.

What Is a Database, Anyway?
A widely accepted definition of a database is “a collection of data related to a particu-
lar topic or purpose.” If that sounds a bit stuffy, just think of a database as a general-
purpose container for storing and managing information. The information can be
anything from names and addresses to details about your business’s inventory and
orders.

There’s more to a database than data. A database can also contain objects to help
you manage that data, such as forms (for entering and editing data) and reports (for
printing data in the format you want). All told, a database can contain any combina-
tion of the following types of objects:

Table Tables are the fundamental structures in an Access database because
they store the data you’ll be managing (see Chapter 6). Within a table, data is
organized into fields (columns) and records (rows). When you open a table, it is
shown in a window called a datasheet view.

OPENING AN EXISTING DATABASE OR PROJECT
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND14

FIGURE 1.4
The Northwind :

Database window with
Tables selected under

Objects.

Query A query is a tool for asking questions about data in your tables and for
performing actions on data (see Chapter 10). Queries can answer questions,
such as: How many customers live in Connecticut, and what are their names
and phone numbers? You can use queries to combine or join data from many
separate but related tables. A query can, for example, join Customers, Orders,
Order Details, and Products tables to answer the questions: Who ordered left-
handed farkledorfers? and What is the value of those orders? Queries can also
help you change, delete, or add large amounts of data in one fell swoop.
Finally, you can use queries as the basis for your forms and reports.

Form Forms let you display and enter data in a convenient format that
resembles fill-in-the-blank forms (see Chapters 11 and 13). Your forms can be
plain and simple or quite elaborate with graphics, lines, and automatic lookup
features that make data entry quick and easy. Forms can even include other
forms (called subforms) that let you enter data into several tables at once.
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Report Reports let you print or preview data in a useful format (see Chap-
ters 12 and 13). Like forms, reports can be plain or fancy. Examples include
mailing labels, lists, envelopes, form letters, and invoices. Reports also can present
query results in an easy-to-understand format. For instance, you can print sales
by customer, receivables aging, and other management information for use in
making business decisions.

Page Data access pages are HTML files that display data in a format that can
be browsed on the Web. Unlike other kinds of database objects, data access pages
are stored in their own files instead of in an Access database or project file.

Macro A macro is a set of instructions that automates a task you need to do
often (see Chapter 21). When you run a macro, Access carries out the actions in
the macro in the order in which the actions are listed. Without writing a single
line of program code, you can define macros to automatically open forms,
print mailing labels, process orders, and more. Macros enable you to assemble a
collection of tables, queries, forms, and reports into turnkey applications that
anyone can use, even if they know little or nothing about Access itself.

Module Like macros, modules allow you to automate and customize Access
(see Part Five). However, unlike macros, modules give you more precise control
over the actions taken, and they require you to have Visual Basic programming
expertise. You may never need to use modules, so don’t worry if you’re not a
programmer.

During the hands-on lessons in Chapter 3, you’ll have a chance to create a data-
base complete with tables, forms, reports, a data access page, queries, and even a sim-
ple form module. You’ll be astounded at how quickly you can do this job when you
let the wizards do all the tough stuff for you.

And What about Projects?
An Access project is a set of database objects that can be used to work with data stored
in tables on an SQL server. A project doesn’t hold any tables or queries of its own. The
only kind of Access objects it includes are forms, reports, macros, modules, and data
access pages. A project can also include these kinds of SQL Server objects: views, data-
base diagrams, and stored procedures.

A project can work with data stored on these servers:

• SQL Server 6.5

• SQL Server 7

• The Integrated Store that comes with Access

AND WHAT ABOUT PROJECTS?
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND16

If you’d like to find out more about working with projects, take a look at Chapter 30.

Working in the Database Window
The database window is one of your main tools for using Access. When exploring the
sample Northwind database and when creating databases or projects of your own,
you’ll use this simple three-step process to work with the objects listed in the database
window:

1. Choose the type of object you want to create, use, or change using the buttons
in the bar on the left side of the database window. That is, click Tables, Queries,
Forms, Reports, Pages, Macros, or Modules.

2. If you want to use or change an existing object, click its name in the list of
objects.

3. Do one of the following:

• To create a new object of the type you selected in step 1, click the
New button along the top of the database window.

• To use (or view or run) the object, click the Open (or Preview or Run)
button.

• To change the object’s appearance or structure, click the Design 
button.

TIP As a shortcut for opening (or previewing or running) an object, you can double-
click its name in the database window.

What happens next depends on the type of object you selected and on the type of
operation you chose in step 3. We’ll say more about the various types of objects in
upcoming chapters.

Closing an Object
Regardless of how you open an object, you can use any standard Windows technique
to close it. Here are three sure-fire methods:

• Click the Close (×) button in the upper-right corner of the window you want to
close (not the Close button for the larger Microsoft Access program window).
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• Choose File ➣ Close from the Access menu bar.

• Press Ctrl+W or Ctrl+F4.

Some Access windows also display a Close button on the toolbar.
If you’ve changed the object you were viewing, you may be asked if you want to

save those changes. Respond to the prompt accordingly.

Uncovering a Hidden Database Window
Sometimes the database window will be invisible, even though you’ve opened a data-
base. If that happens, you can return to the database window (assuming the database
is open) by using any of these techniques:

• Press the F11 key.

• Choose Window ➣ Name: Database from the menu bar (where Name is replaced
by the name of the open database, such as Northwind).

• Click the toolbar’s Database Window button (shown at left).

If none of those methods works, close any other objects that are on the screen and
try again. If you still can’t get to the database window, you’ve probably closed the
database. To reopen the database, choose File from the Access menu bar and then
click the name of the database near the bottom of the menu. Or use File ➣ Open as
discussed earlier in this chapter.

NOTE When you open some databases, a custom form window, rather than the data-
base window, will appear. That’s because whoever created that database has turned it into
an application. Even so, pressing F11 usually will take you to the database window (unless
the application designer has disabled this feature). Often you can bypass the initial form
window and all the other startup options by holding down the Shift key as you open the
database.

Changing Your View of Database Window Objects
You can use options on the View menu, or equivalent buttons on the database win-
dow toolbar, to change the size of objects and the amount of detail listed for them.
Table 1.1 summarizes these options and buttons. In Figure 1.4, for example, we
clicked the List button on the toolbar (alternatively, View ➣ List) to display data-
base objects in a list.

WORKING IN THE DATABASE WINDOW
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND18

TABLE 1.1: VIEW MENU OPTIONS AND EQUIVALENT TOOLBAR BUTTONS

VIEW MENU OPTION BUTTON DESCRIPTION

Large Icons Shows each object as a large icon with the object
name below the icon. Object names initially
appear in rows; however, you can drag them as
needed.

Small Icons Shows each object as a small icon with the object
name next to the icon. Object names initially
appear in horizontal rows; however, you can drag
them as needed.

List Shows each object as a small icon with the object
name next to the icon. Object names appear ver-
tically, in one or more columns.

Details Shows each object as a small icon with the object
name next to the icon. Object names appear with
one object to a line and five columns of detail
about each object. The columns list the object’s
Name, Description, date/time Modified, date/time
Created, and object Type.

• To resize a column, move your mouse pointer
to the vertical divider that’s just to the right of
the column heading. When the pointer changes
to a crosshair, drag the mouse to the left or right-
click or double-click the divider for a snug fit.

• To sort a column in ascending order, click the
appropriate column header button. To sort the
column in descending order, click the column
header button again.

• To add a Description to any object, right-click
the object name in the database window, choose
Properties, type a description, and then click OK.

Note: You can use the View ➣ Arrange Icons and View ➣ Line Up Icons commands on the menu bar
(or right-click a blank area on the database window and choose the View ➣ Arrange Icons or View ➣
Line Up Icons options from the shortcut menus) to rearrange and align icons as needed. (If you don’t
see these choices on the View menu, click the arrows at the bottom of the menu to show more
choices.)
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Working with Groups of Objects
At the bottom of the bar on the left side of the database window under Groups is an
item called Favorites. This is a place where you can add objects you use frequently,
regardless of their type. Then, when you click the Favorites button, these objects
appear in the database window together, instead of being separated by type.

Adding Objects to the Favorites Group
If you want to add an object to the Favorites list, first click the button on the Objects
bar for the right type, to bring the object into view. Then right-click the object and
select Add to Group ➣ 1 Favorites from the shortcut menu that appears. When you
click the Favorites button under Groups, you’ll see the object you added on the
Favorites list.

Creating a New Group
If you’re working with a complex database that includes many objects, you might
want to group the objects into more than one category. For this reason, Access lets
you create your own groups and add them to the database window Objects bar. Any
group you add will appear under Groups, along with the Favorites button.

To create a new group, right-click any item under Objects or Groups and choose
New Group from the shortcut menu that appears. Then enter a name in the New
Group window and click OK.

TIP After you add new groups to the Objects bar, there won’t be enough room to dis-
play all the object types. You can use the Show More button just above Groups to bring
them into view. Or, resize the database window to make it longer, and drag Groups down
to make more room for the Objects list.

Adding Objects to a New Group
To add an object to a new group, follow the instructions for adding an object to the
Favorites list with this change: instead of choosing 1 Favorites, select the new group
from the shortcut menu that appears after you select Add to Group.

Deleting a Group
If you don’t need to use a group anymore, you can remove it from the Groups list on
the Objects bar. Just right-click the group’s name under Groups and choose Delete
Group from the shortcut menu.

WORKING IN THE DATABASE WINDOW
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND20

Managing Database Objects
The database window lets you do much more than just open objects. You also can use
that window to manage the objects in a database—that is, to copy them, delete them,
rename them, and so on. Here’s how:

1. If the object you want to work with is currently open, close it, as described ear-
lier under “Closing an Object.”

2. If you haven’t already done so, choose the type of object you want to work with
(by clicking Tables, Queries, Forms, Reports, Pages, Macros, or Modules in the
database window). Click the name of an object and then:

• To delete the object, choose Edit ➣ Delete or press Delete; click Yes when
prompted for confirmation. To delete the object and move it to the Win-
dows Clipboard (without being asked for confirmation), hold down the
Shift key while pressing Delete or press Ctrl+X. (Be careful, there’s no undo
for this operation; however, you can paste the object from the Clipboard by
pressing Ctrl+V.)

• To rename the object, click the object name again (or choose Edit ➣
Rename), type a new name (up to 64 characters, including blank spaces if
you wish), and then press Enter.

• To copy the object into this same database, choose Edit ➣ Copy or press
Ctrl+C. Then choose Edit ➣ Paste or press Ctrl+V. Enter a valid object name
(up to 64 characters), choose other options as appropriate, and then click
OK. The copy will appear in the list of objects in its proper alphabetical
position. (You may need to scroll through the object names to find the
copy.) Copying can give you a head start on designing a table, form, report,
or other object that is similar to the object you copied. You can then change
the copied object without affecting the original.

• To create a shortcut icon on the Windows Desktop for the selected
object, choose Edit ➣ Create Shortcut, specify the Location (if you wish),
and then click OK. In the future, you can double-click the shortcut icon on
the Windows Desktop to start Access and open the object in one fell swoop.

TIP Another way to create a shortcut to an Access object is to size the Access window
so that you can see Access and the Windows Desktop at the same time. (One way to do
this is to right-click an empty place on the Windows Taskbar and choose Cascade.) Then, if
you want to put the shortcut in a folder, open that folder in Windows Explorer, My Com-
puter, or Network Neighborhood. Finally, drag and drop the selected Access object to the
Desktop or folder. You also can drag and drop tables and queries from the database win-
dow to Microsoft Excel, Microsoft Word, and other program windows (see Chapter 4).
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• To print the object, choose File ➣ Print, press Ctrl+P, or click the Print
toolbar button (shown at left). Then click OK from the Print dialog box to
print the entire object.

• To preview the object before printing, choose File ➣ Print Preview or
click the Print Preview toolbar button (shown at left). When you’re done
previewing the object, close it as described earlier under “Closing an Object.”

• To save the object with a new name in the same database, choose
File ➣ Save As.

• To export the object to a Web Page, another Windows program,
or to a different Microsoft Access database, choose File ➣ Export.
Complete the dialog box and click OK.

• To import or link data from another program or database, choose
File ➣ Get External Data and then choose either Import or Link Tables.
Complete the dialog box that appears and then click the Import or Link
button.

TIP Many of the operations described above also are available when you right-click an
object or right-click any gray area on the database window. See “Opening Shortcut Menus”
later in this chapter for details.

See Chapter 7 for more information about moving and copying objects between
databases or about interacting with other programs. Or search the Access Help index
for any of these topics: Exporting Data, Importing Data, and Linking.

Using the Toolbars and Menu Bar
Toolbars offer time-saving shortcuts to commonly used commands. To use the toolbars:

1. Move the mouse pointer to the toolbar button you want to choose.

2. Wait a moment, and a brief description (called a ScreenTip) will appear near the
mouse pointer, as shown below.
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3. Do one of the following, depending on the type of button you’re pointing to
(see Figure 1.5 for examples):

• For a square (normal) button, click the button.

• For a drop-down button, you have two choices. Either click the picture
part of the button to take whatever action the picture shows, or click the drop-
down arrow next to the picture and then choose an option from the menu or
palette that appears.

• For a drop-down list, click the drop-down arrow next to the box and
then choose an option from the list that appears, or click the drop-down
arrow and then type your choice into the text box.

FIGURE 1.5
Examples of 

square (normal) 
buttons, drop-down
buttons, and drop-

down lists on toolbars.

NOTE If you change your mind about choosing a drop-down button or drop-down list
after you’ve clicked on its drop-down arrow, click the drop-down arrow again or click an
empty area outside the toolbar.

TIP If the drop-down button opened a palette, you can drag the palette anywhere on
the screen. After you detach the palette from its button, the palette remains open and
available until you click the Close button on the palette, click the arrow next to the drop-
down button, or close the object you’re working with.
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Viewing Toolbars, ScreenTips, and the Status Bar
Toolbars, ScreenTips, the status bar, and other on-screen features are optional and cus-
tomizable. If you don’t see one of these features in Access, chances are it’s just hidden
(or turned off).

To display (or hide) the status bar or the startup dialog box (shown in Figure 1.1):

1. Open any database window. (The Tools ➣ Options and Tools ➣ Startup com-
mands described below are available only when a database is open.)

2. Choose Tools ➣ Options from the Access menu bar and then click the View tab.

3. Select (check) an option to display (or turn on) the feature; deselect (clear) the
option to hide (or turn off) the feature. For example, select Status Bar and
Startup Dialog Box to display the status bar and startup dialog box described in
Chapter 4. Click OK.

To display or hide ScreenTips (the descriptions that appear when you point to a
toolbar button):

1. Choose View ➣ Toolbars ➣ Customize from the Access menu bar and then click
the Options tab.

2. Select (check) Show ScreenTips on Toolbars to show a brief description of what a
toolbar button does when you point to it.

3. Click Close.

You also can customize many startup features for the current database (including
whether the database window, status bar, and built-in toolbars appear). To do so,
choose Tools ➣ Startup. You’ll see the Startup dialog box shown in Figure 1.6. As
usual, you can select (check) options you want to turn on and deselect (clear) options
you want to turn off. You also can type text into the text boxes and choose options
from the drop-down lists. When you’re finished making changes, click OK. See Chap-
ter 16 for more about personalizing Access.

FIGURE 1.6
This sample Startup

dialog box shows
default options that
work well for most

people. Choose 
Tools ➣ Startup 

to get here.
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CHAPTER 1 • GETTING STARTED AND GETTING AROUND24

NOTE Pressing the Shift key when you open the database will bypass any Startup
options that you’ve changed, giving you the default options shown in Figure 1.6.

Showing More of a Menu
Some of the drop-down lists for Access menu choices, such as Edit, come in two ver-
sions: a short list of the most commonly used commands and a longer list with extra
commands. When you’re viewing the short version of a drop-down list, it will have a
Show More button like the one shown for the Edit menu here:

To see the long version of a menu, click its Show More button. Or, just leave the
menu open for a few seconds without making a choice. The short version will then
transform into the longer list on its own, if there is one available. The long version of
the Edit menu looks like this:
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Positioning the Toolbar or Menu Bar
By default, the toolbar is docked just below the menu bar (refer to Figure 1.4). You can
convert the toolbar to a free-floating element or dock it to some other edge of the
screen. You can also move the menu bar or dock it in a new location. Follow these
steps to move the menu bar or a toolbar:

1. Move the mouse pointer to the handle on the left side of the toolbar.

2. Drag the menu bar or toolbar toward the center of the screen, double-click to
make it free-floating (see the example below), or drag it to some other edge of
the screen to dock it there. To restore a floating menu bar or toolbar to its previ-
ous docked position, double-click its title bar.

When the toolbar is floating freely, you can drag it by its title bar to any place on
the screen. Here are some other toolbar tips:

• To close (hide) the floating toolbar, click the Close button on the toolbar’s
upper-right corner or right-click any toolbar and click the toolbar’s name in the
shortcut menu that appears. (Shortcut menus are discussed in the next section.)

• To redisplay a hidden toolbar, choose View ➣ Toolbars, click the check box
next to the toolbar you wish to view, and then click the Close button in the
Toolbars dialog box.

• To redisplay a default toolbar for the current view, right-click any visi-
ble toolbar and then click the toolbar’s name in the shortcut menu that appears.

If the redisplay procedures above don’t work, choose Tools ➣ Startup, select
(check) Allow Built-In Toolbars, and then click OK. Close and then open the database
again. If necessary, choose View ➣ Toolbars to redisplay the toolbar.

NOTE If you manually show a built-in toolbar, it will appear in every view. If you hide a
built-in toolbar from within its default view, it will be hidden in every view (including its
default view).

We discuss many other ways to use and customize the toolbars in Chapter 24. But
for now, just knowing how to hide, display, and position the toolbar is enough. If you
do need a quick reminder or more information on toolbars, use the Office Assistant to
find help for Toolbars.
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Opening Shortcut Menus
Access provides many shortcut menus to save you the trouble of looking for options on
the menu bars and toolbars. Shortcut menus in the Open and Save dialog boxes also
offer handy ways to manage your files and folders without leaving Access.

To open a shortcut menu that’s tailored to whatever you want to work with, right-
click the object or place you’re interested in, or click the object and then press Shift+F10.
For example, right-clicking a table name in the database window opens this menu:

NOTE If the shortcut menus don’t appear when you right-click, choose Tools ➣
Startup, select (check) Allow Default Shortcut Menus, and click OK. Then close and open
the database again.

To select an option from the menu, do one of the following:

• Press Enter if you want to choose the boldfaced option on the menu.

• Click the option with either the left (primary) or right (secondary) mouse button.

• Type the option’s underlined letter or highlight the option with your mouse,
and then press Enter.
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To close the menu without selecting an option, press Esc, Alt, or Shift+F10—or
click outside the menu.

TIP The term right-click means to point at something with your mouse pointer and
then click the right (secondary) mouse button. (If your mouse is set up for lefties, you’ll
have to click the left mouse button instead.) This right-click trick is available throughout
Access (and, indeed, throughout Windows). As you work with Windows and Access, be
sure to experiment with right-clicking. It is a great way to discover some truly useful shortcuts.

Closing a Database or a Project
When you’re done working with a database or a project, you should close it. Any of
these methods will work:

• Click the Close button in the upper-right corner of the database window.

• Go to the database window and then choose File ➣ Close from the Access
menu bar.

• Press Ctrl+W or Ctrl+F4.

As usual, you’ll be prompted to save any unsaved work.

NOTE You can have only one database open at a time. Access will automatically close
the currently open database if you choose File ➣ Open or File ➣ New before closing the
database or project that’s open.

Getting Help
One thing we hope to teach you in this book is how to get answers to questions—
even if we haven’t provided those answers. You can achieve this goal easily if you
learn how to use Access’s plentiful built-in Help. We’ll show you how to use this self-
help tool next.
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Summary of Self-Help Techniques
Table 1.2 summarizes many ways to get and use online Help in Access. Remember
that you can use all of the standard Windows techniques while you’re in the Help sys-
tem to annotate Help, print a topic, change fonts, and so forth. For more information
on those topics, see your Windows documentation or the Windows online Help. You
can experiment by right-clicking in any Help text window and choosing options from
the shortcut menu.

TABLE 1.2: MICROSOFT ACCESS 2000 ONLINE HELP OPTIONS AND TECHNIQUES

TYPE OF HELP HOW TO GET IT

Office Assistant Choose Help ➣ Microsoft Access Help, or click the Office
Assistant button on the toolbar.

Table of Contents Choose Help ➣ Microsoft Office Help, click the Office
Assistant’s Search button, and click the Contents tab in
the Help dialog box. If the Contents tab isn’t visible, click
the Show button first.

Search Help Click the Index tab in the Help dialog box.

Find Help on the Web Choose Help ➣ Office on the Web.

Display a Minimized Help Window Click the ? Microsoft Access Help button on the Windows
Taskbar.

What’s This…? Choose Help ➣ What’s This?, press Shift+F1, or click the
? button on the toolbar or at the upper-right corner of a
dialog box; then click the command or place you want
help with.

Choose Help ➣ About Microsoft Access.

Exit Help Click the Close button at the upper-right corner of a Help
screen.

Using the Help System and This Book
This book is designed to complement the Help system, not to replace it. Because the
online documentation does such a good job of showing you the steps for practically
any procedure you can perform in Access, and because many of those procedures
won’t interest everyone, we’ve taken a more conceptual approach here—one that
should help you work more creatively. Instead of presenting hundreds of little step-

Version Number, System
Information, Technical Support
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by-step instructions (as the Help system does), this book deals with larger, more 
general concepts so that you can see how (as well as when, why, and sometimes
whether) to apply the nitty-gritty details you’ll find in the Help system.

Looking Up Information
Like a book, the Access Help system has a table of contents, which is a great way to
learn how to do things. To get to the Help contents:

• Use the Office Assistant to open any Help topic, click the Show button if the left
pane of the Help window is not visible, and then click the Contents tab in the
Help dialog box.

Or

• If you’re already in a Help window and the Contents side of the Help window
isn’t visible, click the Show button on the left side of the Help toolbar to return
to the Contents Answer Wizard or Index tab you selected most recently.

The Contents lists many options to explore. Figure 1.7 shows the Contents tab
with the Data: Find book opened. To open or close a book, click the Expand or Col-
lapse button before the book’s name, or just double-click the book. To display a topic
(preceded by a question mark icon, like this ?), click that topic. In Figure 1.8, you see
the Help window that opened after we expanded the Data: Find book and then
clicked on the About Using Wildcard Characters topic.

FIGURE 1.7
The Contents displays
electronic books filled

with help on many
topics. Double-click

books to open or close
them. Click topics to

display them.
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FIGURE 1.8
A Help window that
shows information

about using wildcard
characters.

Here are some tips for using a Help window (see Figure 1.8):

• To view Help text that’s hidden at the moment, use the vertical and hor-
izontal scroll bars as needed, or resize the Help window.

• To jump to a related topic, click the small button next to that topic in the
help text. The mouse pointer changes to a pointing hand when you point to a
jump button.

• To see the definition of a term or a button, click any text that’s under-
lined, or click a picture of a button. (Click anywhere inside or outside the defin-
ition, or press Esc to hide the definition again.)

• To print the current Help window, click the Print button on the Help win-
dow toolbar.

• To return to the previous Help window, click the Help window’s Back
button.

• To show the Help Contents if it’s not visible, click the Show button on the
Help window’s toolbar.
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• To make the Help window reappear if it’s minimized or hidden, click the
Microsoft Access Help button on the Windows Taskbar. (The button name is
preceded by a small ? icon.)

• To close the Access Help window, make sure it’s the active window and
then click its Close button.

Help with Whatever You’re Doing
Even when you’re not in a Help window, you should look at the status bar, preview
areas, and any colored text on the screen for hints on what to do next. For example,
you’ll often see a hint box on the object and a description of available shortcut keys
in the status bar, as shown in Figure 1.9. (Though that example won’t appear until
you design a table, as discussed in Chapter 6.)

FIGURE 1.9
Hint boxes and the sta-

tus bar often provide
further information

about what to do next.

Searching Help
Like any good book, the Help system also has its own index. You can search the index
for help with just about any topic. Here’s how:

1. Go to the Help window as explained earlier in this chapter and then click the
Index tab. Figure 1.10 shows the Index tab’s contents after we typed wildcard
in the text box and clicked Search.

2. Type a word or select one from the list of topics. Search is not case sensitive. This
step highlights the closest match to your entry in the list(s) below the text box.

3. Click Display (or double-click a topic).

Status bar information Hint box
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FIGURE 1.10
The Index tab after we

typed wildcard in the
text box.

Once the Help topic is shown on the right side of the Help window, you can use
any of the techniques described earlier to work with that information (see “Looking
Up Information”).

Asking the Office Assistant
The Office Assistant enables you to search for information by typing in a few words. The
more specific your words are, the more on-topic the suggested topics will be. But you
don’t have to worry about matching a topic name exactly because the Office Assistant
is pretty forgiving and even quite smart.

To use the Office Assistant, choose Help ➣ Microsoft Access Help from the Access
menu bar, press F1, or click the Office Assistant button on the toolbar (see Figure 1.11).
You can choose from several personalities for the assistant. Just click the Options
button in the yellow bubble for the assistant and click the Gallery tab. Besides choosing
the appearance of the assistant, you can change its behavior. Click the Options tab
in the Office Assistant dialog box, make your selections, and click OK.
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FIGURE 1.11
The Office Assistant

showing Help topics on
customizing toolbars.

To get help from the Office Assistant, first open the assistant if it’s not already visi-
ble on the Desktop. If you don’t see a yellow bubble with a Search button, click any-
where on the assistant, and then type a few words describing what you want to do in
the box under “What would you like to do?” and press Enter or click the Search but-
ton. When the list of related topics appears, click the topic you’re interested in to
open the corresponding Help entry.

In Figure 1.11, we typed customize toolbars and pressed Enter. The Office Assis-
tant ignores extraneous words, such as how do I fix, and focuses on the important key-
words, such as toolbar and customize. It then displays a list of topics that seem to
answer your question.
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Asking “What Is This Thing?”
Another way to get quick information is to use “What’s This?” Help. This type of help
explains the function of menu commands, buttons, or dialog box options.

1. Press Shift+F1 or choose Help ➣ What’s This? from the Access menus. If you’re
in a dialog box, click the ? button in the upper-right corner of the dialog box.
The mouse pointer changes to a combination arrow and question mark.

2. Click a button on the toolbar, select commands from the menus, or click a place
in the dialog box to get help with that particular item.

If you change your mind about using What’s This? Help before choosing a topic,
press Esc or Shift+F1, or click the Help or ? button again, to return to the normal
mouse pointer.

Here are some other ways to get What’s This? Help:

• In a dialog box, right-click the option name or button you’re curious about and
choose What’s This?

• In a dialog box, click or tab to the place you want help with and then press
Shift+F1 or F1.

• In the menus, highlight the option you want help with and then press Shift+F1
or F1.

Version Number, System Information, Technical Support
Do you need to check the version of Access you’re using to see how much memory
and disk space are available or to find out how to get technical support? It’s easy:

1. Choose Help ➣ About Microsoft Access to open the About Microsoft dialog box.

2. Click the System Info button (for information about your system resources) or
click Tech Support (for details about getting help from humans).

3. Click the Close and OK buttons (or press Esc) as needed to return to Access.

Getting Out of Help
You can get out of Help in many ways, but the easiest is simply to make sure the Help
window is active (Click the window or its Taskbar button if you need to.) and then
click its Close button.
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NOTE In addition to the online Help described in this chapter, Microsoft offers many
other sources of help for Microsoft Access, Microsoft Office, and other Microsoft products.
See Chapter 4 for information about these additional resources.

Exiting Microsoft Access
When you’re done using Access, you should return to Windows before shutting down
and turning off your computer. You can exit from Microsoft Access using the tech-
niques you’d use with other Windows programs:

1. Go to the database window or to the main Microsoft Access window.

2. Choose File ➣ Exit, click the Close button in the upper-right corner of the
Microsoft Access window, or press Alt+F4.

You’ll be returned to Windows or to another open program window.

TIP To exit Access when Access is minimized, right-click the Microsoft Access button on
the Windows Taskbar and then choose Close.

Where to Go from Here
Where you go from here depends on your past database experience.

• If you’re new to Access and to databases, continue with Chapters 2 and 3.

• If you’re new to Access but know something about databases, try the
hands-on guided tour in Chapter 3.

• If you’re familiar with Access, flip to the “What’s New in the Access Zoo”
section at the end of most chapters in this book, including this chapter. For
another view of what’s new, open the Office Assistant, enter What’s New, and
then click a What’s New topic.
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What’s New in the Access Zoo?
Some of the many features discussed in this chapter are new to Access 2000. New fea-
tures include:

• Projects, special Access files that hold objects for working with SQL Server data

• Show More buttons on some of the Access menus

• A new Open dialog box with buttons for quickly showing the file lists for History,
My Documents, the Desktop, and your Favorites

• A revised database window with buttons for optionally displaying objects by group
instead of by type

• A revamped Help system that’s easier to navigate

• New Office Assistant personalities
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